IHCTPYKLIA
3 KOPUCTYBaHHA CEpBICOM
Cited-by Big CrossRef

ANA peAaakuin HayKoBUX XXypHarniB

KonecHukoBa T.0., sianosiaanbHum cekpetap ypHany «Hayka
Ta NPOrpec TpaHCNoOpPTY», K.H. i3 couia/IbHUX KOMYHiKaLUil, C.H.C.,
ANPEKTOP HAayKOBO-TeXHiUHOi 6i6niotekn AHY3T (m. AHinpo)

ConossaHeHkKo A.B., aupekrop TOB «BuaasHuya cayx6a YPAH»,
KOOpAUHaATOP NPOEeKTy «HaykoBa nepioguKa YKpaiHU», K.iCT.-HayK
(m. Knis)

CasenbeBa O.A., meHepKep calTy KypHany «Hayka Ta nporpec
TPAHCNOPTY», 3aB. Biaainy iHGopmauiMHUX TEXHONOTiA HayKOBO-
TexHiuHoi 6ibniotekn AHY3T (m. AHinpo)

2018



Ha wo 3BepHyTH yBary?

* BUKOpUCTAaHO AO0CBiA poboTn peaakuii XXypHany
«Hayka Ta nporpec TpaHCNopTy»
http://stp:diit.edu.ua/

* }ypHan po3tawoBaHo Ha naatdpopmi «HayKosa
nepioguka YKkpaiHu» Ha YPAH (BuagaBHuua cucrema

0JS) - http://journals.uran.ua/

* MMpun pobori 3 Cited-by Biag CrossRef npautoemo aK
«PepakKktop xypHany» (I-i1 eran) Ta « MeHeaXep
XypHany - Journal Manager» (ll-u etan)

* Ha nepwomy etani mosa iHTepdeuncy poni He rpae, Ha
APYromy = Ti/IbKM aHINiNCbKa

e 3aHeCeHHA AaHUX BiabyBaeTbCA B pyYHOMY pPEKUMI
Ana 36epexeHHA ocobausocrteun 6ibniorpadiuHoro
onucy B APA-style



http://stp.diit.edu.ua/
http://stp.diit.edu.ua/
http://stp.diit.edu.ua/
http://journals.uran.ua/
http://journals.uran.ua/

BuaaHHSA XKYPHaNy NiaTPUMYETbCA HAaYKOBO-

TexHiyHoto b6ibniorekoro AAHY3T

(https://library.diit.edu.ua/) Ha npuknaai KpaLmux cBitToBMUX
npakTuk Library Publishing - https://librarypublishing.org/

%) ABTOPH3aUIA

HAYKOBO-TEXHIYHA BIBJ/TIOTEKA

AHINPONEeTPOBCLKUIA HaLioOHaNbHWUIA YHIBEPCUTET

3aNi3HWYHOro TPAHCNOPTY iMeHi akagemika B. NlazapsHa Mowyk 1

[po 6i6nioteky v EnekTpoHHa 6i6nioteka v Penoautapin v E-BuiaBHNLTBO ¥ lanepes TBOpYOCTI KoHTakTu

A\
B [1po npoekT

E-xypHanu

E-KoHdepeHuil

§ E-kHurm (cTopiHka

H 3HaX0AMTbCA B PO3pO6LL)



https://library.diit.edu.ua/
https://librarypublishing.org/

CROSSREF CITED-BY LINKING

https://lwww.crossref.org/services/cited-by/

 Cited-by ponomarae yneHam AisHaTUCA, XTO LLUTYE IX
KOHTEHT, BifobparKa€e NiYUNbHUKU i NOCUNAETLCA HA
LMUTOBAHMWU KOHTEHT...

* Kopucrtysaui (Bugasui) Cited-by gonomaraiotb cBoim
YynTayam:

- Ierko.nepexoamTu A0 BiaNOBIAHNX AOCNIAXEHD;

- NOAUBUTUCA, HACKIZIbKM BE/IMKOIO € CNiNIbHOTA, W0
oTpumana pobory;

- AOCNIAXYBATHU, AK iaei eBONIOUIOHYIOTb i3 YacoMm,
BUAINAIOUYM 3B'A3KU MiXK poboTamm.



OpHopasosi MAroToBYI Al ansi po6oTy
I3 Cited-by Bia CrossRef (>ypHan Ha OJS)

|. Akwo y Bac we HE HanawToBaHUM «[TOMIYHUK pO3MITKKM UnUTaT», TO MeHeaxep
canTty NOBMHEH Lie 3p06MTM (r| 3 7 CITATION MARKUP ASSISTANT HaJ'IaLIJTyBaHb

KYpHany) -- nocTaBmm FafIoYKY.

2.V n. CITATION EXTRACTION SERVICES r|0Tp|6Ho o6paTM RegEx (pO3I‘II3HaBaHHFI
LMTAT 3@ 4ONOMOTO0 PEFYNAPHNX BUPA3iB)."

3.7 IIOMIUHHWK POSMITKHM ITMUTAT

J1a TOro. o0 BEITIOYHTH QYHKINOHAIBHICTE A% peJarvBaHHg IpHCcTaTedHol O10morpadii.
AKTHEVHTE Opanopeus HEKYe. 1€ JOZBOJIHTE aBETOPAaM BEIIOYATH J0 IIOJ3aHE OPHI1HAIBHI
CIIHCKH OpPHCTAaTeHHOI 010morpadii. Kpinm TOoro. pegaxropaM Oyae HagaHa MOKIHEBICTE
BEHKOPHCTOEVEAZTH NOMIYHHK PO3MITKH OHTAT, SKHH J3a€ 3MOTY NePEBIPAETH KOPEKTHICTSE 1
TOYHICTS OPHIMIHATHEHHX HETAT HIISXOM 3B S2KV 3 30BHIMITHIMHE 0a3aMH JaHHX. TAKHMH JK
WorldCat, ISBNdb, PubMed 12 15m11. IligTEepITKeH1 METATH MOXKYVTE eKCOOPTVEATHCE vV dadau
D1HATEHHX I'PAaHOK.

e

JozeoauTtH [JOMIYHHEK PO3MITEKH ETAT

CJI.‘ }I{EI/I EKCTPAK I lIi HHTAT JdonarH eIeNMeHT

IIIar03

PeecTpaniiisa indopManisa Ta napaMeTrpu
OIJIFO3Y

4 Penarvearn €) Bunamwma

.

RegEx




MponoexenHss OaHopazosi MIArOTOBYI Ol ansi po6oTn
i3 Cited-by Big CrossRef ()kypHan Ha OJS)

* wob po3ain "Untyerbea y..." BigobparkaBca Ha CTOPiIHKaX CTaTew,
CMOYATKY MeHeaKep KYpPHaay NoBUHEH BKAOUYNUTU moaynb Cited-
by y po3aini. 3araabHi moayai. ., ABToOpu. HaBenu Ana npuknagy
KapPTUHKY 3 YHKE BKIIOYEHUM MOAYAEeM, TOMY Ha Hill NpUCyTHA
dyHKUia «BIARSHOHYUTU»

SacaTesHI MOV I

SarajJibsbH1 MOJIVJII1

SaramgsEHi MOIVIII JOZECISIOTE OSITATHEMAE IMNIIEX3ANME POIINHPHTH QVHEKIIIOHEaTIEHICTE Open
Journal Sy stems.

NMOIAYJIb TINYMCE

ITJefHi 2MO0OVTISs JOZBOI=EE W YSIW Y G pegarvEaHHEST TEKCTOEEX nDomdie OJS z2a JomoMOoTOoRo
pegaxTopa 3MicTV LinvNCE.
BIOOKJIFOYHTET

NMOJIVIIb CITED-BY ILINKING

ITesH MOIVIS JO3BOI=EE @VHEEKIIOEATIEHICTSE CrossRef Cited-byv Linking
BIJRKJIFOYHTEH

TIJTAT TH <« AT . NM>»

Ilei OTIAT1H B1J00PAaEac HA CAaHTI KINBNICTS OEepPSIfISIiE OKPEeMOI CTaTTI - MEeTpHEHE CTIaTT:
(Article Level Nietrics) 23 OKpPEeMHH MICHOS 300 pIkK. JJ3aHI E1JOOPAHIFOTHECHE vV BHITIS A1
rpadika EHH3IV CITOPIHEH OKpPeNMOol CTaTTi.

HAJTTATITTVBAHHSA BIOAKJIFOYIITIE



[MPAKTUKA POBOTMW 3 Cited-by

1 avuw T TT1 =Y N AITOTTONTY i1 ITTTL
{1\. YyRd 1da 11poO1 pPCoC 14 naCiil | DICHONRN
TT

I u eTan

I'Ipau,loemo AK
K Pe,anTop XypHany»

(MOBGI :Hmepdyeucypom He 2pae)



Kpok 1. Obupaemo pons PEOAKTOPA
XypHany AnAa 3aBaHTaXeHHs References

A
vk . pomye pascnopry. o, HTyOneTRORSROTD BAORATEHONY VHBEDITTy SATISHHSHON :
TRy
» NEAEANED KypHany
% e ) ety S Pedaryimcs Craom sy [Choscmimt KopHcryBae
et egemis SPegyones
» o) 00 Aiet) 2860 A Hoge nogates)

 PelgeAT [ A



Kpok 2. Y TELI PEOAKTOPA obupaemo
nigpo3pin «flonepegHi BUNYCKU»

ITOJAHHA

» Heonpaneoeami (200)
» Perer3vIoTeCE ()

¥ PemarvioTecd (3)

¥ APMHIEH

Hazea v MICTHMTE v
Haaicnado v ik | | v Y 1al ..
MoLLy K

BIHIIVCKII
¥ CTEOPHTH EHITVCE
» CIIOBICTHTH KOPHCTVEITIE

¥ NMaimoyTHI BHITYV CEH
» 1 lommepen BHITY CKH




Kpok 3. Y nonepegHix BUnyckax oobnpaemo
HeoOXiaAHUN HOMep XypHany

CTBOPMTHEMITVCK ~ MANEVTHIBIIIVCEII — IIOMEPETHI BHITVCKH

ITeft ;2 pHAT EHKOPHCTOBVE HECTAHJAPTHE COPTYRAHHA BHITycKiE. CEITHYTII COFTYBAHHA 10 CTAHTAFTHOIO

OIIVEIKOBAHI  CTATEIL COPTVBAHHA ik
e EELEESS 2 r;als[}ﬁz:f ........................ 1 3 ......................................... l ........................................... e
Ne 2(74) (2018) 2018-05-29 13 | BHIATITH
Ne 1(73) (2018) 2018-03-12 13 | BHIATITH
Ne 6(72) (2017) 2018-01-12 13 | BHIATHTH
Ne 5(71) (2017) 2017-11-22 15 | BHIATHTH
Ne 4(70) (2017 2017-00-11 14 | BIHIATIIH
Ne 3(69) (2017) 2017-06-21 16 | BUIATITH



Kpok 4. Obupaemo B paHOMy HOMepi
)KypHany HeoOXigHy cTaTTio

Havka Ta
‘TTT;T TT

T A TN , sy Edai ;
[Iporpec TpaHCIIOPTY. DICHIK

3AJIISHHIIHA KO TIHT l
ABTOPID  HAJRA
Fischer, TEIABHIET
T Al 1 }'.'

y Neweh | IEEVRAE
Harach | uycro JATZHIMHOTO.
Juhasz

BIIATTH

[IEPEBIPEHO



Kpok 5.'Y npeacrasneHomy Pe3tome cTaTTi
odoupaemo byHKUIO References

PEZFOME PEIIEH3YBAHHA PEJAT YBAHHA ICTOPLA FEFERENCES

ITOJAHHA

AEBTOP(H) S. Fischer, A Nemeth, D. Harrach, E. Juhasz =
CTIELTIATIEHHI METO OLTHEM PYHHVBAHHA YACTOK 3ATISHHUHOIO BATACTT

Hasea VHIKATTBHOID JIABOPATOPHOI O BHITPOEVBAHHA
OpHriHATEHHH
pafin Heuae
Cymp. daitma  Hemae JOJATH CYTIPOBILTHIIT $ART
Hagicaae 0. Yu. Aksenova =J
Hata 2018-06-21
HAaTICHIIAHHA
3MIHHTH HAa
. IATIIZHITUHA
Pozmit oL ISMISHHHHA KONIS
2anunc I
Tlepernsmie q

AHOTALTIT



Kpok 6. 3Hanommmocs 3 (pyHKLIisMHU
«MoMIYHMKA PO3MITKU LUTAT»

PE3KOME PEINEH3YBAHHA PEJAT YBAHHA ICTOPIA REFERENCES

‘ BCTVYII ‘ | TTOBHOEKPAHHUIA PEHUM |

BAC BITA€ ITOMIYHHWK PO3MITKII
IHMTAT!

Lled NoOMiMHME QoNoMarae po3mivaTi UMTarti, Hagadi asTopom, Ans
X nogansloro ekcnopty Yy XML-rpadkd MLM 2.3 abo 3.0, 4uM
OQOpPMNEHHA AK TEKCTOBMX ONOKIE. IHCTpYMeHT pobKnTe cnpody
ABTOMATHYHOT EKCTPaKLl Ta po3nizHaBaHHA UWTaT y TOMY BUIMAQI,
AK BOHW HagaHI asTOpOoM. ANe BH MOXETE pefaryBaTi OTpUMaHI
pe3yneTaTk y OyOb-AKMA Yac.

« KoHdpirypauisa noMivHMKa



Kpok 7. Obupaemo pyHKLiIo
«PeparyBaHHA uuTaT»

#1346

4655 Iluraru

PESKOME

PEITEHSYVBAHHA  PEJATYVEBAHHA

EFEFEEENCES

‘ PEIAT'YBAHHA [MTAT

PEJAI'VBATHU
[MUTATH

2 0 0 0 0 o

(+

[1]1 Ambrus, K., &amp; Pallds, |. (201
<ems {fem}{em}Z{fem}{em}u-:f

R A FEp—— PSR ———— P PN ISR

[2] Arangm P. B. D. {1997). The infl
International Heawvy Haul Railway Co

[2] Claisse, P., &amp; Calla, C. (2004

Transport, 159(2),</em> 69-74. doi

[4] Douglas, 5. C. (2013). Ballast Qu

<em= F’aper (Knoxville, Tennessee,

ArE A, g I T W TN N I S S

[ TLDES 918 061: Technische Liet
2006/08. {in German)

[8] Fischer, 5. (2015). A vasOti z0zo

MOBHOEKPAHHMI PEXIUM |




Kpok 8. Y niBomy BikHi obupaemo

HeoOXiAHY LUTAaTY (B npasiit YacTUHI — NOKM LWO

HeMallUHO34YUTYBaHUMN TEKCT)

PEJIAIYBATH [IMTAIH

Q

[1] Ambrus, K., &amp: Pallos, |. (2012). <em>{j</em><emst</em><emzb</ems<em>p</em><eme{</em<em:
<pm: {,’em>{em>2{/em>~ﬁem}uf:/em:w:em}zottk{femHemm{Xem}{emwek{/emr»f:emr» B</pm=<em>s</e

cmvnn mobblemiimnnle o lnman cawmas o lneas e memEaleliniine o fnman cmimnn Ao faman cmimmen leale o fomae omimee

[2] A rangie, P. B. D. (1997). The influence of ballast fouling on the resilient behaviour of the ballast pavement la;

International Heavy Haul Railway Conference (Cape Town, April 6-10),</em> 241-256. (in English)

(3] Claisse, P., &amp; Calla, C. (2006). Rail ballast: conclusions from a historical perspective. <em>Proceedings ¢
Transport, 159(2),</em> 69-74. doi: <a href="ttps://doi.org/10.1680/tran.2006.159.2.69°>10.1680/tran.200

oooo'?oo

[4] Douglas, S. C. (2013). Ballast Quality and Breakdown during Transport. <em>2013 Joint Rail Con ference</en
<em> Paper (Knoxville, Tennessee, USA April 15</em=<em>-</em><em=18)</em>.doi: <a href="https://doi.ol

A 1A 111 FARSAAT Y AFET o fan fin Faalicki

(5] TLDBS 918 061: Technische Lieferbedingungen Gleisschotter. TL DBS 918 061: Technical delivery condition:
2006/08. (in German)

[6] Fischer, 5. (2015). A vas(t z(zottkdvek aprozodasvizsgalata eqyedi laboratriumi madszerrel. <em=Sinek V
Hungarian)

[7] Fischer, 5. (2017). Breakage Test of Railway Ballast Materials with New Laboratory Method. <em=Periodica Po
</em> 794-802. doi: <a href="https://dol.org/10.3311/ppci.8549°10.3311/PPci.8549+</ax (in English)

JUdnar, ey i

‘conf-proc)).

OpHriHanbHItii TEKCT LUTaTH




Kpok 9. Y npaBomy BikHIi obnpaemo tun
nyonikauii — «Journal»

Hayxka Ta nporpec Tpa"crnopry. BicHHK

T[nrluﬁclp BCHKOTO HAIllOHAJIBHOTO YHIBEPCUTETY

=T

[1] Ambrus, K., &amp: Pallds, I. (2012). <em>U</em><em>t</em><em>&</em><em>p</em><em>{</em=<em: -

{em} {/emHem}Z{/emHem}u{/emHem}zottk{/emﬂemr«o</em>~~cemwek</em>~{em} g</em=<em>s</e

e i cnwman matbleaiiinenle o laman cnmmnn o lamnsn cnmes memFalelenisne o lnmne cnmne Ao laman cnmne leale o lammn cnane

[2] Arangie, P. B. D. (1997). The influence of ballast fouling on the resilient behaviour of the ballast pavement la
International Heavy Haul Railway Conference (Cape Town, April 6-10),</em> 241-256. (in English)

rahs

[3] Claisse, P, &amp; Calla, C. (2006). Rail ballast: conclusions from a historical perspective. <em=Proceedings
Transport, 159(2),</em=> 69-74. doi: <a href="https://doi.org/10.1680/tran.2006.159.2.69">10.1680/tran.200

0O 0 0|00 | 0 | O

[4] Douglas, S. C. (2013). Ballast Quality and Breakdown during Transport. <em>2013 Joint Rail Conference</en
<em> Paper (Knoxville, Tennessee, USA, April 15</em=<em>-</em=<em>18)</em> doi: <a href="https://doi.ol

ArFA" 1A 1110 ARSAAT Y A o fan i Faalialt

[S] TL DBS 918 061: Technische Lieferbedingungen Gleisschotter. TL DBS 918 061: Technical delivery condition:
2006/08. (in German)

[6] Fischer, S. (2015). A vasati zuzottkovek aprozodasvizsgalata egyedi laboratoriumi modszerrel. <em>Sinek V
Hungarian)

[71 Ficrhar € (2017% Rroalkana Tect nf Railwav Rallacr Matariale with Naw I ahnratary Mathnd <cam=Parindira Pn

L-mai;

FYUHE PEIATYBAHHA

CIIYXEM LWUTYBAHD

GOOGLE AKATIEMIA

SAIMTATH ABTOPA

Tanmymika ¥ journal

. HATHCHITE Croam,



Kpok 10. Y npaBomy BikKHi 3anOBHIOEMO BCI nons,
no4ynHaro4vm 3 nona «ABTopu», Ta 3aKIH4yEMO
dyHKUIiE «3anucaTtu Ta NiaTBEepAUTU»

[,,W‘Y A K I r‘ Y 1 )

Tun nySnika v journal

ABTOPH hd Claisse P._ Calla ¢
OData nyonik 2006

Hazea ctarr v Rail ballast: conc
Hazea #ypH ¥ Proceedings of tt
Mepwa ctop v 69

COCTAHHA CTC ¥ 74

Bunyck v 2

T b 1559

Dol v 1016880,/ tran.20

ISﬁeperrH | | JanucaTtHv Ta nigTeepdvuTy I




Kpok 11. Burnag mawmMHO34YUTYyBaHOI LUTATMU.
3aKiH4YeHHA «PepgaryBaHHA uutaT» nicnsa oopoodKu
BCboOro References Ha l etani «PegakTop XypHany»

Hayka Ta nporpec TpaHcnopty. BiCHHIK
JIHIIPONIETPOBCHKOTO HAIIOHATIBHOIO YHIBEPCHTETY

3AJISHIYHOIO TPAHCIIOPTY

ATiRATin

f/eme69-74. doi. <a href="https/ /doi.org/10.1680/tran.2006.159.2.69'+10.1680/tran.2006.159.2.69< /3 (in English

0 4] Douglas, S. C. (2013). Ballast Quality and Breakdown during Transport. <em>2013 Joint Rail Conferences/en
<prt> Paper (Knoxville, Tennessee, USA, April 15</em<gm-</ams<eme18)x/eme doi <a href="hteps://doi.of

ArrA 1A 11 F AIRAAAT Y AT o fan fin Faaliakl



II I/I eTan
f Journal Manager

(npaumemo MinbKu 3 dH2iUCbKUM
leedeeucom)



Kpok 12. 3mMiHIOEMO pOsni BUKOHaBLIB.

3 aHrNINCbKOI CTOPIHKU 3aXxoaANMO SK

Journal Manager

HOME ABOUT USER HOME SEARCH CURRENT
ARCHIVES ANNOUNCEMENTS FOR AUTHOES REVIEWERS
INDEXING LIST OF JOURNALS

OPEN JOURNAL SYSTEMS

Home = User Home

User Home

LANGUAGE

Select Language

| English v
Submit

|

SCIENCE AND TRANSPORT PROGRESS.
BULLETIN OF DNIPROPETROVSK NATIONAL
UNIVERSITY OF RAILWAY TRANSPORT

» Journal Manager [Setup]

. 200 0In 5In .
o -TTe o
» Editor Unassigned Review  Editing [Create Issue] [Notify Users]

0In 5In

» Section Editor : o
Review  Editing

200 2660 . o
i . . '\ r “ g
» Author Active Archive [New Submission]

» Reviewer 0 Active

MY ACCOTINT

2 [~
=

NV

JOURNAL CONTENT

Search

Search Scope
| Al v

Search I

Browse

By Issue

By Author

By Title

Other JTournals
Categories




-Kpok 13. MNMpwu ynpaBniHHi KypHanowm (journal
management) obupaemMo CTOpiHKY
Import / Export Data

Hayxka T: eC TPaHCIOPTY. BICHHK

HOME ABOUT USER HOME SEARCH CTUUREENT
ARCHIVES ANMNOUNCEMENTS FOR AUTHORS REVIEWERS
INDEXIMNG LIST OF JOURMALS

Home = User = Journal Managemenr

Journal Management

MANAGEMENT PAGES

» Announcements
» Files Browser

» Journal Sections
» Review Forms
» Languages

» hlasthead

» Prepared Emails
» Feading Tools

» Setup

» Stats & Reports
» Payvments

» Svatem Plugins
» Import Export Thata
» External Feeds



"7 Kpok 14. Ha ctopiHui Import / Export Data
obupaemo nnaruH CrossRef XML. Export
Plugin (Cited-by Linking) =

TT

Import/Export Data

o DataCite Export/Registration Plugin: Export or register 1ssue, article, galley and
supplementary file metadata in DataCite format.

o JGate XML Export Plugin: Export article metadata in JGate XML format.

o DOAT Export Plugin: Export Journal for DOAJ and supply journal information for inclusion

s QuickSubmit Plugin: One-step submission plugin

o METS XML Export Plugin: Export Journals in METS XML

o PubMed XML Export Plugin: Export article metadata in PubMed XML format for indexing
in MEDLINE.

o Articles & Issues XML Plugin: Import and export articles and 1ssues

s Users XML Plugin: Import and export users

s Erudit Article Export Plugin: Export articles using the English Erudit DTD

o CrossRef XML Export Plugin (Cited-by Linking): Export article metadata and references in
CrossRef XML format.

s DuraCloud Import CXport Plugin: Archive and restofe 155ues using an external DuraCloud
service for storage

o Public Identifiers XML Plugin: Import and export public identifiers

o CrossRef Export/Registration Plugin: Export or register article metadata in CrossRef format.

* mEDRA Export/Registration Plugin: Export issue, article and galley metadata in Omix for
DOI (04DOI) format and register DOIs with the mEDRA registration agency.




Kpok 15. EkcnopTtyeMo AaHi yepe3 Export Issues
Ha cTtopiHUi CrossRef XML. Export Plugin (Cited-
by Linking)

:
! UL T = T1 T1 T iror -
Havka Ta [IpOorpecC TPaHCII( PTY. DICHIHK

Home = User = Journal Manager > Import/Export Data > CrossRef XML Export Plugin (Cited-

by Linking)

CrossRetf XML Export Plugin (Cited-by
Linking

EXPORT DATA

» Export Issues

T ERpUIT AT




“Kpok 16. Ha cTopiHul Select an Issue to export —
apxiB HOMepIB XXypHany. EKcnopTtyemo
onpauboBaHUu HamMmu Homep. CchopmoBaHUN
chaiin HagcuNaeMo, e-NowTo Ao odicy
«BupasHnyoi cnyx6m YPAH», komaHaa siKoi
nicns nepeBipku ekcnoprtye dann B Crossref

HOME ABOUT USER HOME SEARCH CUREENT
ARCHIVES ANNOUNCEMENTS FOR AUTHORS REVIEWERS
INDEXING LIST OF JOURNALS

Home = User > Jowrnal Marnager = Import/Export Data > CrossRef XN Export Plugin (Cited-by

Linking) = Select an Issue fo export.

Select an Issue to export.

ISSUE PUBLISHED ITEMS ACTION

MO 3(75) (2018) 2018-06- 13 EXPORT
27

MO 2{74) (2018) 2018-05- 13 EXPORT
29

NO 1(73) (2018) 2018-03- 13 EXFPORT
12

NO 6(T2) (2017 2018-01- 13 EXPORT
1z

NO S5(71) (2017) 2017-11- 15 EXPORT
22

MO 4{70) (2017 2017-05- 14 EXPORT

11



B3aemoaisa cepBepy "HaykoBa nepioguka
YkpaiHn» Ha YPAH ta Crossref
BiAOyBaeTbLCH Ha NPOrpaMHOMY PiBHI

* npouec nepesipkn popmarty AaHunx
(https://www.crossref.org/02publishers/parser.html)

* npouec nepesipku 3micty panny XML

* npouec peectpauii danny B Crossref

* npouec nepeBipku.nomunok...Crossref Haagcunae 3sir,
Yy AKOMY. N0 KOXXHOMY NYHKTY 6ibniorpadii BKa3aHo

pe3ynbraT peecTpauil. AKWO € NTOMUNKKU, AKI BapTO
BMNPABUTU, NPO Le NOBIAOMAAETLCA peaaKuii

* MOBTOPHE NepeaaBaHHA OHOBAeHOro ¢aiiny Ao
Crossref y BUnagKy, AKWO peaaKkuia Bunpasuia
NOMMUNKHU



7K uMTYBaHHA 3'ABRAAOTLCA HA CTOPIHKaX
craten?

* Lle BiabyBa€eTbCcA aBTOMATUYHO.

e Konn Kopuctysau 3axoanTb Ha CTOPiHKY CTATTi HA CaMTi
KypHany, cepsep B perumi OHNAUH OTPUMYE AaHi
LLLOAO LUTOBAHOCTI L€l cTaTTi 3a AaHUMM Crossref
Cited-by.

* Lli paHi Bigobparkatorsca B po3aini "Untyerbca y..." y
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ABSTRACT

Purpose. Development of domestic and global transport science occurred due to the contributions oLy
of many scientists and practicing engineers. T he purpose of our study is the analysis of scientific
documentary legacy of YE. P. Blokhin, Doctor of Technical Sciences, Professor of Dnipropetrovsk Meparnza
National University of Railway Transport named after Academician V. Lazaryan and identifying his

place and role 1in the development of modern railway transport. Methodology. Application of
problem-chronological, comparanve, descriptive historical methods of research, systematization and

analysis of scientific papers allowed the authors to submit the actual history of the railway transport

development (1950-2013) through the prism of YE. P. Blokhin scientific acuvity. We identified 6

main periods of his scientific activity. Findings. It wwas found out that the overall intellectual plant

of the scientist includes 5535 scientific papers (A\written personally and co-authored) in domestic and

foreign publications on key issues of mechanics and operation of railway rolling stock. Artistic
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